Mercury™ IT Governance Center
Processing Requests
(Demand Management)
Version 5.5.0

This manual, and the accompanying software and other documentation, is protected by U.S. and
international copyright laws, and may be used only in accordance with the accompanying license
agreement. Features of the software, and of other products and services of Mercury Interactive
Corporation, may be covered by one or more of the following patents: U.S. Patent Nos.
5,701,139; 5,657,438; 5,511,185; 5,870,559; 5,958,008; 5,974,572; 6,138,157; 6,144,962;
6,205,122; 6,237,006; 6,341,310; 6,360,332, 6,449,739; 6,470,383; 6,477,483; 6,549,944;
6,560,564; 6,564,342; 6,587,969; 6,631,408; 6,631,411; 6,633,912 and 6,694,288. Other patents
pending. All rights reserved.
Mercury, Mercury Interactive, the Mercury Interactive logo, LoadRunner, LoadRunner TestCenter, QuickTest Professional, SiteScope, SiteSeer, TestDirector, Topaz and WinRunner are
trademarks or registered trademarks of Mercury Interactive Corporation or its subsidiaries, in the
United States and/or other countries. The absence of a trademark from this list does not constitute
a waiver of Mercury Interactive's intellectual property rights concerning that trademark.
All other company, brand and product names are registered trademarks or trademarks of their
respective holders. Mercury Interactive Corporation disclaims any responsibility for specifying
which marks are owned by which companies or which organizations.
Mercury Interactive Corporation
1325 Borregas Avenue
Sunnyvale, CA 94089 USA
Tel: (408) 822-5200
Fax: (408) 822-5300
© 2004 Mercury Interactive Corporation. All rights reserved.
If you have any comments or suggestions regarding this document, please send them via e-mail to
documentation@merc-int.com.

Publication Number: ProcessRequests-0304A

Table of Contents
Chapter 1
Introduction ................................................................................................................. 1
About This Document...........................................................................................................1
Intended Audience ..............................................................................................................2
Document Conventions ........................................................................................................2
Additional Resources ...........................................................................................................3
Related Documentation ....................................................................................................3
Customer Support ...........................................................................................................4
Education Services ..........................................................................................................4

Chapter 2
Key Concepts............................................................................................................... 5
Requests .............................................................................................................................5
Request Type.......................................................................................................................6
Request Header Types .........................................................................................................8
Workflows ..........................................................................................................................9
Workflow Steps ..................................................................................................................9
Request Status...................................................................................................................10
Dashboard........................................................................................................................11
Portlets .............................................................................................................................12
References ........................................................................................................................13
Help on Requests and Request Fields ..................................................................................14
Displaying Mercury ITG Data .............................................................................................15

Chapter 3
Accessing Demand Management ................................................................................ 17
Logging on to the Standard Interface..................................................................................17
Changing Your Password ..................................................................................................19
Launching the Workbench .................................................................................................20

Table of Contents

iii

Processing Requests (Demand Management)

Chapter 4
Creating a Request..................................................................................................... 23
Creating a Request ............................................................................................................23
Creating a Request from the References Section ...............................................................26
Copying Requests..........................................................................................................27
Adding References ............................................................................................................28
Attaching Requests ........................................................................................................30
Attaching Packages .......................................................................................................33
Attaching Releases ........................................................................................................36
Attaching Projects .........................................................................................................37
Attaching Tasks.............................................................................................................39
Referencing a URL in Demand Management....................................................................42
Referencing an Attachment in Demand Management .......................................................42
Valid References ...........................................................................................................43
Reference Dependency Relationships ..............................................................................44
Saving an Un-Submitted Request .......................................................................................46
Adding and Editing Contacts..............................................................................................46
Adding a Contact..........................................................................................................46
Editing an Existing Contact ............................................................................................48

Chapter 5
Viewing Request Status and Details ............................................................................ 51
Searching for Requests ......................................................................................................51
Searching for a Specific Request.....................................................................................52
Using Simple Searches ..................................................................................................52
Using Advanced Searches .............................................................................................55
Saving your Searches ....................................................................................................56
Viewing Request Information .............................................................................................59
Viewing the Workflow Step Information URL....................................................................60
Viewing the Graphical View of the Request .....................................................................60
Viewing the % Complete ................................................................................................61
Viewing the Approval Details of a Step ...........................................................................62
Viewing the Members of a Security Group for a Step .......................................................63
Viewing the Request Transaction History .........................................................................64
Viewing the Request Execution Log .................................................................................65
Viewing the Request or Request Field Help .........................................................................66
Printing a Request .............................................................................................................67
Using Dashboard Portlets to View Request Information .......................................................69

Chapter 6
Processing Requests ................................................................................................... 71
Request Processing - Data Integrity ....................................................................................71

iv

Table of Contents

Processing Requests (Demand Management)

Locating In Progress Requests ............................................................................................72
Using Searches .............................................................................................................72
Using Notifications ........................................................................................................72
Updating Request Information............................................................................................73
Updating the Request Header.........................................................................................74
Updating Request Details and Notes ...............................................................................76
Updating Request References .........................................................................................77
Updating Request Status ................................................................................................79
Spawning a New Request from a Request .......................................................................84
Creating a New Package From the Request .....................................................................85
Re-Opening Closed Requests..........................................................................................87
Configuring Workflow Display...........................................................................................88

Chapter 7
Managing Requests ................................................................................................... 89
Deleting Requests ..............................................................................................................89
Canceling Requests............................................................................................................90
Printing Requests...............................................................................................................91
Using Reports to Manage Requests ....................................................................................92
Resource Load Report by Priority ....................................................................................93
Request Detail Report.....................................................................................................93
Request Summary Report ...............................................................................................93
Submitting a Report.......................................................................................................94
Using the Dashboard to Manage Requests..........................................................................94

Chapter 8
Mercury Demand Management Reports ...................................................................... 95
Reports .............................................................................................................................95
Processing Reports ............................................................................................................98
Submitting a Report from the Workbench........................................................................98
Submitting a Report from the Standard Interface ............................................................101
Viewing Previously Submitted Reports from the Workbench ............................................103
Viewing Previously Submitted Reports from the Standard Interface ..................................104

Appendix A
Integrating Requests and Projects .............................................................................. 105

Table of Contents

v

Processing Requests (Demand Management)

vi

Table of Contents

Processing Requests (Demand Management)

Chapter

Introduction
Mercury Demand Management is an application used to manage technology
initiatives (Demand) from inception to implementation. Initiatives are
generated via Requests, which are processed using a graphical Workflow
business modeler.
A critical component for tracking and managing demand in an organization
involves logging and resolving individual Requests in the system. Demand
Management features tools and configurable processes for dealing with these
Requests. Data is captured by prompting users of the Request for processspecific information. This ensures the required information is collected and
validated at the appropriate time in the process. Complex business rules can be
followed by using different approval methods. Prioritization and delegation
features allow Requests to efficiently advance through their specific
Workflow, routing them to relevant departments, groups or individuals.
Users can monitor the status of a Request from their desktop using a Web
browser. Email and pager notifications are generated as the Request passes
through various stages of the process, keeping all project members informed.
Throughout the process, users are prompted to enter additional information,
appropriate to their specific Task. Management reports and Dashboard views
are also available to help monitor technology initiatives and service levels.

About This Document
This guide describes how to use Demand Management. Each chapter covers a
specific topic on navigation or usage:
Key Concepts

Describes the general concepts of Mercury Demand
Management. This includes Requests and Workflows.

Introduction
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Accessing Demand
Management

Details how to logon to the standard interface.

Creating a Request

Provides the procedures on how to create a Request.

Viewing Request
Status and Details

Shows how to view an existing Request.

Processing Requests Describes how Requests can be tracked and processed.
Managing Requests Show how Requests can be viewed, changed or deleted.
Mercury Demand
Lists the procedures on how to submit and view reports.
Management Reports
Integrating Requests Details how to link Projects and Requests.
and Projects

Intended Audience
The intended audience for this document include:

• Users of Demand Management
• Managers who create and manage Requests
• Business users responsible for creating and processing Requests

Document Conventions
Table 1-1 lists the types of conventions used in this document.
Table 1-1. Document conventions
Convention

Description

Example

Button, menu, tabs

Names of interface components that can be
clicked (such as buttons, menus, and tabs)
are shown in bold.

Apply button

Fields, Windows, Pages

Names of windows, fields, and pages are
shown as displayed.

New Request window
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Table 1-1. Document conventions [continued]
Convention

Description

Example

Code

Code input and output are shown as
displayed.

CauchoConfigFile
C:/ITG_Home/conf/
resin.conf

Link

Linked URLs, filenames, and cross references
are shown as blue italicized text.

www.mercury.com

Variable

Variables are shown as italicized text.

ITG_Home/bin directory

Note

Used to identify note boxes that contain
additional information.

Caution

Used to identify caution boxes that contain
important information. Follow the instructions
in all caution boxes, failure to do so may result
in loss of data.

Example

Used to identify example boxes that contain
examples of related procedure.

Additional Resources
Mercury Interactive provides the following additional resources to help you
successfully use Mercury ITG Center:

• Related Documentation
• Customer Support
• Education Services

Related Documentation
The Library includes additional documents related to the topics discussed in
this guide. Access the Library through the Mercury ITG Center online help.

Introduction
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Using the Dashboard

This document provides details for defining and
configuring the Dashboard and custom Portlets.

Managing Your Projects (Project This document explains how to work with Projects
Management)
using Project Management.
Security Model Guide and
Reference

This document presents an overview of the data
security model and provides instructions for
controlling access to different entities.

Reports Guide and Reference

This document provides details for running
reports.

Configuring a Request
Resolution System

This document provides instructions for
configuring a Request resolution system. This
includes requirements gathering, modeling your
processes in a Workflow, defining a Request Type
to be integrated with the Workflow, and rolling out
this system to your users.

Customer Support
Customer support and downloads for Mercury ITG Center and additional
product information can be accessed from the Mercury Interactive Support
Web site at http://support.mercuryinteractive.com.

Education Services
Mercury Interactive provides a complete training curriculum to help you
achieve optimal results using the Mercury IT Governance Center. For more
information, visit the Education Services Web site at http://www.merctraining.com/main/ITG.
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Key Concepts
This chapter defines the common concepts and terms used in Mercury Demand
Management. Understanding these concepts and terms is necessary when using
Demand Management.
This chapter covers the following topics:

• Requests
• Request Type
• Request Header Types
• Workflows
• Workflow Steps
• Request Status
• Dashboard
• Portlets
• References
• Help on Requests and Request Fields
• Displaying Mercury ITG Data

Requests
A Request is the fundamental work unit of Demand Management. A Request’s
detail page contains all of the information that is typically required to complete
a specific business process. Requests with similar or related functions can be
grouped into Request Categories, making them easier to locate and use.

Key Concepts
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A Request has an associated Request Type that determines which fields are
included in a Request’s detail page. As a Request goes through its steps, users
are prompted for all of the information necessary to bring the Request to
closure. Once the basic Request information has been entered, the
corresponding Workflow is automatically selected, based on the Request Type.
A Request:

• Is the fundamental “work unit” within Demand Management.
• Is the repository for all of the information necessary to take a series of
actions and move through a standard business process.

• Is a specific execution of a business process. Each Request is identified
by a unique Request Number.

Figure 2-1 Demand Management Request

Request Type
A Request Type is a general category defining the structure of a Request in
Demand Management. Demand Management includes such pre-defined
system Request Types as the Bug Request Type and Enhancement Request
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Type. The fields used when a Request is created are customizable based on the
Request Type.
The base installation of Demand Management is seeded with default Request
Types and Request Header Types that can be modified to meet the needs of the
business. The Request Type is also used to determine the default Workflow
through which a Request is routed, as well as the Request Category of the
Request. Custom Request Types and custom Request Header Types can be
copied from default configurations and modified or created from scratch.
A Request Type:

• Is the framework that defines the behavior of a Request as it moves
through a business process.

• Determines the logic behind (and provides the framework for) the storage
and manipulation of data within a Request.

• Represents a different process within a business. The Request Type can
be defined to capture different kinds of data and follow different business
and resolution processes.

Figure 2-2 shows a Demand Management Request Type.

Figure 2-2 Demand Management Request Type

Key Concepts
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Request Header Types
Request Header Types define a collection of fields appearing in the header
region of the Requests using that Request Type. The presentation and
validation of these fields depends upon the Request Type. When creating or
configuring a new Request Type, associate a Request Header Type with that
Request Type. Figure 2-3 shows a Request Header Type.

Request Header Type
A Request Header Type can be thought of as a basic template for the header
area that appears at the top a Request. Request Header Types have the
following characteristics:

• Provides a framework for the storage and manipulation of Request header
data.

• Represents attributes common to multiple types of Requests. Header data
is useful for locating and reporting certain types of Requests. Examples of
Header Data are Creator, Assigned User, Description, Summary, and
Department.

• Labels and arranges header fields in a manner most familiar to specific
Business Units.

Figure 2-3 Request Header Type
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Workflows
A Workflow is a logical series of steps defining a process that Requests follow.
Workflows can be configured to handle virtually any business practice. This
allows a department to create Workflows to automate existing processes, rather
than forcing users to adopt a fixed set of processes to perform their work.
A sample Workflow for an Application Enhancement is shown in Figure 2-4.

Figure 2-4 Visual Workflow

Workflow Steps
Workflow Steps are the events that are linked together to form a complete
Workflow. Demand Management uses three types of Workflow Steps:

• Decisions
• Executions
• Conditions
In a Decision step, a user or group of users needs to indicate an outcome, such
as an approval of work or an indication that a review has been completed. For
example, Review Request is a Decision step.
In an Execution step, the system performs an action and then updates the step
with the result. These actions can be as simple as calculating the value for a

Key Concepts
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token or as complex as copying files, running programs and updating Web
pages.
Conditions are logic steps used for complex Workflow processing, such as
allowing the Workflow to proceed only when each of three different steps are
completed. Figure 2-5 shows the steps of a typical Workflow.

Figure 2-5 Workflow Steps

Request Status
A Request Status is a summary indicator of the current state of a Request. For
example, a Request can have a Request Status of New, Assigned or In Progress.
Request Statuses are automatically set as the Request moves through its
Workflow.
Request Statuses are user-defined and attached to Request Types. Each
Request Type can have different Request Statuses. For example, the Request
Status Request Approved might be in an Enhancement Request Type but not in a
Bug Request Type. Behavior can be defined for individual Request Statuses,
such as requiring information in specific fields for Requests at specific Request
Statuses.
A Request’s status can be viewed on the Header section of the Request’s detail
page, as shown in Figure 2-6.
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Figure 2-6 Request Status on a Request’s detail page

Dashboard
Mercury ITG Dashboard consists of a set of configurable, role-based visual
displays called Portlets. These Portlets provide relevant summary information
and highlight exception conditions. From these Portlets, users can drill down to
any desired level of detail. The Dashboard displays the true status of initiatives
and Requests, based on the current data. Current data is automatically captured
as part of the work actually being performed.
The Dashboard is designed for use by participants throughout your IT
organization. For example, developers can use the Dashboard to view all their
own Action Items, and end-users can consult their own Dashboards to see the
status of all the Requests they have submitted. Tabs in the Dashboard interface
allow users to group Portlets according to their own needs. Figure 2-7 shows
Mercury IT Governance Dashboard.

Key Concepts
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Figure 2-7 Mercury IT Governance Dashboard

Portlets
Portlets are configurable, role-based visual displays providing relevant
summary information of business data. The application administrator can
assign and configure Portlets to a user’s Dashboard. Additionally, each user
can select which Portlets they want on their Dashboard. They can then
personalize those Portlets to display only the information that is relevant to
their Projects, Tasks, Packages, or Requests.
In addition to providing relevant information for higher visibility, Portlets also
provide the user with the ability to drill down into the details of the Project,
Task, Request or Package. This enables the user to access and update
information from a single Web page.
Mercury IT Governance Center features a set of Portlets for each Mercury ITG
product. These Portlets are designed to provide the most efficient and flexible
access to business data. It is also possible for the application administrator to
create custom Portlets to suit a particular business need. Figure 2-8 shows a
typical Portlet.
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Portlets can only be added to a Dashboard that is associated with the products
licensed at your site. For a full list of the available Portlets, see Using the
Dashboard.

Figure 2-8 Portlet

References
In addition to header and detail field information, Requests can have references
to other entities or points of information. This allows for easy access and
visibility to related data. Summary information for References is viewed as
part of the Request. Figure 2-9 shows the Reference drop-down menu.

Figure 2-9 Request References

Each reference can be viewed in detail with a click of the mouse. There are
several reference types defined in Demand Management:

• Attachments
It is possible to attach a file from a local machine to the current Request.
The attached file is copied to the server and can then be accessed by other
Demand Management users. This feature is particularly helpful for
referencing a document that is not already Web accessible.

• Requests
References can be added to Requests to relate to other Requests. In

Key Concepts
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addition to referencing existing Requests, a Request to be referenced can
be created from the References tab. A relationship (informational or
dependent) can then be specified between the Request and the new
Reference. See “Adding References” on page 28 for more details.
For Requests that were spawned from a step in the Request Workflow step,
references to the Requests are automatically generated, establishing a twoway tie between the spawned Request and the original Request.

• Packages
A reference can be added to an existing Package. For Requests that spawn
Mercury Change Management Packages, references to the Package(s) are
automatically created. This establishes a two-way tie between the Request
and Package.
A new Package to be referenced can also be created from the References
tab. The relationship (informational or dependent) between the Request
and the new reference can be specified, such as successor, predecessor or
child of this Request. See “Adding References” on page 28 for more
details.

• Task
Mercury Project Management Tasks are associated to the current Request
using Mercury Project Management. Varying dependencies can be set
between the Request and the Task. Tasks can also be created from
Requests in Project Management. See “Adding References” on page 28 for
more details.

• Project
A current Request can be attached to a Mercury Project Management
Project. The Project is then associated with the Request.

• Documents (URL)
It is possible to reference an unlimited number of documents to a given
Request. These documents need to be Web accessible and are referenced
by simply entering the Web address (URL) of the document. Once
attached, the documents can be opened by selecting the reference.

Help on Requests and Request Fields
Help on Requests and Request fields provides customizable help content for
Requests in Demand Management. Fields, sections and Request Type help
content can be edited by the application administrator to meet the specific
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needs of the business. The result is that where help content is configured (on a
field, section, or Request Type), end users can move to that help content by
). Figure 2-10 shows a typical Dashboard
clicking the Help Content icon (
page with Help Content icons.

Figure 2-10 Help on Requests and Request Fields

Displaying Mercury ITG Data
As more of your business processes and solutions are modeled using Mercury
ITG Center, the data in the system will grow. For example, you can use
Mercury Change Management to automate 200 different processes — thus
potentially introducing 200 Workflows. Sifting through 200 entries in an autocomplete list or 200 search results could be cumbersome.
Mercury ITG Center can be configured to display only information that is most
relevant to a specific business role. Depending on this configuration and the
Access Grants given by the application administrator, some data will not
display when, for instance, clicking on an auto-complete list or performing a
search for a particular entity.

Key Concepts
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A Project Manager and a Software Developer can each have different Access
Grants. Each sees different sets of Requests Types and Workflows when
clicking on auto-complete lists or running searches, with each set suited to
their particular business role.
For more information on Access Grants and data, refer to the Security Model
Guide and Reference.
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Accessing Demand Management
Mercury Demand Management is a Web-enabled software system. The
software can be executed using certain Java-enabled Web browsers, such as
Netscape Communicator 7.02+, or Microsoft Internet Explorer 5.0+.
Mercury IT Governance Center features two interfaces:

• Standard interface
The standard interface uses HTML and Javascript to provide users with
access to many key areas of functionality, such as creating and processing
Requests and running reports. Demand Management users primarily
interact with the standard interface.

• Mercury IT Governance Workbench interface
The Workbench is a Java applet designed to help application
administrators, product configuration personnel, and Power Users perform
advanced configuring and processing tasks, such as creating Request Types
and Workflows.
This chapter covers the following topics:

• “Logging on to the Standard Interface” on page 17
• “Changing Your Password” on page 19
• “Launching the Workbench” on page 20

Logging on to the Standard Interface
The standard interface is accessed through a Web browser over a network. This
section details the steps required to logon to Mercury Demand Management.

Accessing Demand Management
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To Logon to Mercury Demand Management:
1. Contact the System Administrator or Webmaster to obtain the following:

• Web address (URL) where Demand Management is installed
• A username
• A password
2. From the browser, access the web address.
The Logon page opens.

3. In Username, enter the username.
4. In Password, enter the password.
To have the server retain a password, click the Remember my logon check
box. Once this check box is selected, a logon password will not be required.

5. Click Submit.
The Dashboard opens. If an incorrect password is entered, you will be
prompted for the correct password. Re-enter the logon information and
click Submit.

18
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Changing Your Password
Some users are forced to change their password upon the initial logon.
To change a password:
1. Logon to Mercury Demand Management.
2. On the menu bar, click Settings > Edit my Profile.
The Edit My Profile page opens.

3. In Old Password, enter the existing password.
4. In New Password, enter the new password.
5. In Repeat New Password, re-enter the new password.
6. Click Done.
An error message is returned if:

• The old password was not correctly entered.
• The New Password and Repeat New Password fields do not contain the
same exact entry.

• The new password is identical to the old password.
The password is accepted if no error message is returned.

Accessing Demand Management
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Launching the Workbench
The Workbench provides an interface accessing advanced processing and
configuration functionality in Mercury ITG Center. The Workbench is
accessed from the Dashboard’s Menu bar.
To launch the Workbench:
1. Logon to Mercury Demand Management.
2. From the Menu bar, select Administration > Open Workbench.

When the Workbench is accessed for the first time, several question dialogues
might appear asking permission to automatically install the Java client
components. Answer Yes in all question dialogues and follow any other
instructions provided in the browser window. Depending on the client’s
connection to the server, this might take several minutes. Subsequent logons
will be much quicker, as the client does not have to install any additional
components on their machine.
Figure 3-1 shows the pop-up window that opens to display the status of the
Workbench. When the Workbench opens, the pop-up window indicates the
Workbench is active. This window must remain open to use the Workbench.

20
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Figure 3-1 Workbench Pop-up window

If a pop-up blocker is installed on your web browser, the Workbench will not
open.

Accessing Demand Management
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Creating a Request
Requests are the repositories for all of the information necessary to take a
series of actions and move through a Workflow.
This chapter covers the following topics:

• Creating a Request
• Adding References
• Saving an Un-Submitted Request
• Adding and Editing Contacts

Creating a Request
Users create Requests every time a standard business process is invoked. The
Request is given a unique number and is tracked from start to finish. This
ensures task completion and accountability for all steps within the selected
Workflow.
To create a new Request:
1. Logon to Mercury Demand Management.
2. From the menu bar, select Create > Request.
The Create New Request page opens.

Creating a Request
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3. In the Create From Available Request Types section, select the Request Type
to generate from the Request Type drop down list.
When selecting a Request Type from the list, a description of the Request
Type is displayed below the field. To save time, the most recently created
Request Types are first on the list. You can also select Request Types in the
Create Based on Desired Action section.
When creating a Request, you might only see the Request Types that are
most relevant to your business role or level of system access. See
“Displaying Mercury ITG Data” on page 15 for more detailed information.
4. Click Create.
The Create New Request page opens. The Header and Detail fields might be
different, depending on the selected Request Type.

24
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5. In the Header section, enter Request Header information.
Required fields have a red asterisk (*). All other fields are optional, but are
often helpful when others are reviewing the open Request. For information
) next to the
concerning a specific field, click the Help Content icon (
field.
6. In the Details section, enter Enhancement information.
Required fields have a red asterisk (*). All other fields are optional, but are
often helpful when others are reviewing the open Request. For information
concerning a specific field, click the Help Content icon (
) next to the
field.
7. In the Notes section, enter additional information.
8. In the References section, add References to the Request.

Creating a Request
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In some cases it might be useful to reference a web accessible file, or attach
a document or file from a local machine to the current Request.
Additionally, other entities such as Packages, Tasks, or other Requests can
be referenced. For more information on adding references, see “Adding
References” on page 28.
9. Click Submit.
The Request is submitted and saved. The Request Creation Confirmed page
opens.

After submitting the Request, you can continue your Demand Management
session by:

• Clicking the link (Request #) to see the newly generated Request’s detail
page.

• Generating a new Request by selecting the Request Type from the Request
Type

drop down list and clicking Create.

Once a Request has been submitted, it is assigned an initial status, such as New.
It is then routed along a standard business process of approvals, decisions,
and/or actions, depending on the associated Workflow. See “Processing
Requests” on page 71 for details.

Creating a Request from the References Section
A new Request can be created from the References section of a Request’s detail
page.
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To create a Request from a Request’s detail page:
1. Logon to Mercury Demand Management.
2. Open a Request.
See “Searching for Requests” on page 51.
3. Scroll down to the Reference section.
4. From the New Reference drop down list, select Request (New).
5. Click Add.
The Create New Request page opens.

6. From the Request Type drop down list, select the Request Type.
7. Select a Relationship by checking the appropriate radio button.
8. Click Create.
The Create New Request page opens.
9. Enter the information relating to the new Request.
10. Click Submit.
The Request is submitted and saved.

Copying Requests
A new Request can be created by copying an existing Request. This can save
time by eliminating the need to re-enter information that is common between
the Requests.

Creating a Request
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To generate a new Request using the copy feature:
1. Open a Request.
See “Searching for Requests” on page 51.
2. Scroll to the bottom of the Request’s detail page.
3. Click Copy.
The Copy Request page opens. All Header and Details fields are copied to
the new Request.

4. Select whether to copy the original Request’s Notes and/or the References
sections.
5. Click Copy.
A new Request detail page opens with the copied information.
6. Modify the new Request’s data as required.
7. Click Submit.
The Request is submitted and saved.
Copied Requests are not submitted by default. Click Submit in the Request’s
detail page to send the Request along its Workflow.

Adding References
Add a reference to a Request from a Request’s detail page. There are several
reference types defined, including:

•

28

Attachment

Creating a Request

Processing Requests (Demand Management)

•

Package

•

Project

•

Release

•

Request

•

Task

•

URL

For some reference types, such as for Packages and other Requests, a
functional dependency to the reference can be created. For example, you can
specify that a Request is a Predecessor to the Package. This means the Package
will not continue until the Request closes.
To add a Reference to a Request:
1. Open the Request.
See “Searching for Requests” on page 51.
2. Scroll down to the References section.
3. From the New Reference drop down list, select the type of reference to be
generated.
4. Click Add.
An additional page opens where the exact reference can be specified.

This page is different depending on the type of reference selected. The
following sections provide instructions for referencing different entities:

• Attaching Requests
• Attaching Packages
• Attaching Releases
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• Attaching Projects
• Attaching Tasks
• Referencing a URL in Demand Management
• Referencing an Attachment in Demand Management
For some reference types, such as for Packages and other Requests, you can
create a functional dependency to the reference. See “Reference Dependency
Relationships” on page 44 for a list of the dependencies that can be set for
each reference type.

Attaching Requests
To attach Requests to a Request:
1. Open the Request.
2. Scroll down to the References section.
3. From the New Reference drop down list, select Request (Existing).
4. Click Add.
The Add Reference: Request page opens.
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5. Search for the Request to add.
To search for the Request:
a. In the Search Information section, enter search criteria.
b. (Optional) In the Result Display Options section, enter the display
options.
c. Click Search.
The page refreshes with the Request(s) matching the search criteria and
a list of relationship types.
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6. Select the type of relationship between the Request and its reference.
Check one of the radio buttons. See Table 4-2 on page 45 for a description
of the relationships.
7. Select the Request to reference.
More than one reference can be selected by checking more than one check
box.
8. Click Add.
The Add Reference page closes and the Request’s detail page re-opens. The
attached Request is listed in the References section.
9. Click Save.
The Request is saved as a Reference and the Request’s detail page is
closed.

A new Request can be created from a Request’s References section and
attached to the current Request. See “Creating a Request from the
References Section” on page 26 for detailed instructions.
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Attaching Packages
To attach a Package to a Request:
1. Open the Request.
2. Scroll down to the References section.
3. From the New Reference drop down list, select Package (Existing).
4. Click Add.
The Add Reference: Package page opens.

5. Enter the search criteria for the Package.
To search for the Request:
a. In the Search Information section, enter search criteria.
b. (Optional) In the Result Display Options section, enter the display
options.
c. Click Search.
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The page refreshes with the Package(s) matching the search criteria. A
list of relationship types is included on the page.

6. Select the type of relationship between the Request and its reference.
Check one of the radio buttons. See Table 4-2 on page 45 for a description
of the relationships.
7. Select the Package to reference.
More than one reference can be selected by checking more than one check
box.
8. Click Add.
The Add Reference page closes and the Request’s detail page re-opens. The
attached Package is listed in the References section.
9. Click Save.
The attached Package is saved as a Reference and the Request’s detail page
is closed.
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Creating a New Package
A new Package can be created from a Request’s References section and
attached to the current Request.
To create a new Package from a Request’s References section:
1. Open the Request.
2. Scroll down to the References section.
3. From the New Reference drop down list, select Package (New).
4. Click Add.
The Create New Package page opens.

5. Select a Relationship by clicking the appropriate radio button.
6. Click Create.
The page refreshes to display the New Package page. Matching header
information is defaulted in the Package page, such as Description, Priority,
and Package Type.
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7. Enter any additional Header or Notes information.
8. Click Save.
The New Package page closes and the new Package is displayed in the
Request’s Reference section.
Package Lines can not be added using the standard interface. Package Lines
must be added using the Workbench. See Processing Packages (Change
Management) for details.

Attaching Releases
To attach Releases from a Request’s References section:
1. Open the Request.
2. Scroll down to the References section.
3. From the New Reference drop down list, select Release.
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4. Click Add.
The Reference Release page opens.

5. In Release, select the Release to reference.
6. Click Add.
The References section in the Request’s detail page is returned. The newly
attached Release is listed in the References section.
7. Click Save.
The Release is saved as a Reference and the Request’s detail page closes.

Attaching Projects
To attach Projects from a Request’s References section:
1. Open the Request.
2. Scroll down to the References section.
3. From the New Reference drop down list, select Project.
4. Click Add.
The Add Reference: Project page opens.
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5. Search for a Project to add as a Reference.
6. To search for a Project:
a. In the Search Information section, enter the search criteria.
b. (Optional) In the Result Display Options section, enter the display
options.
c. Click Search.
The page refreshes with the Project(s) that match the search criteria. A
list of relationship types is included.
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7. Select the Project to reference.
More than one reference can be selected by checking more than one check
box.
8. Click Add.
Return to the References section in the Request’s detail page. The newly
attached Project is listed in the References section.
9. Click Save.
The attached Project is saved as a Reference and the Request’s detail page
is closed.

Attaching Tasks
To attach Tasks from a Request’s References section:
1. Open the Request.
2. Scroll down to the References section.
3. From the New Reference drop down list, select Task.
4. Click Add.
The Add Reference: Task page opens.
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5. Search for the Task to add as a Reference.
To search for a Task:
a. In the Search Information section, enter the search criteria.
b. (Optional) In the Result Display Options section, enter the display
options.
c. Click Search.
The page refreshes with the Task(s) that match the search criteria. A list
of relationship types is included.
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6. Select the type of relationship to assign between the Request and its
reference by clicking one of the radio buttons.
See Table 4-2 on page 45 for a description of the various relationships that
can be assigned.
7. Select the Task to reference.
Select more than one reference by checking more than one check box.
8. Click Add.
The References section in the Request’s detail page is returned. The newly
attached Task is listed in the References section.
9. Click Save.
The attached Task is saved as a Reference and the Request’s detail page is
closed.
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Referencing a URL in Demand Management
To add a URL as a Reference:
1. Open the Request.
2. Scroll down to the References section.
3. From the New Reference drop down list, select URL.
4. Click Add.
The Reference URL page opens.

5. In URL, enter the URL.
6. In Description, enter a description.
7. Click OK to add the specified URL as a Reference.
8. The referenced URL appears in the References to be added on Save list on
the Request’s detail page.
The Reference has not been added yet.

9. Click Save.
The Reference is added to the Request.

Referencing an Attachment in Demand Management
To add an attachment as a Reference:
1. Open the Request.
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2. Scroll down to the References section.
3. From the New Reference drop down list, select Attachment.
4. Click Add.
The Reference Attachment page opens.

5. In Attachment, click Browse to locate and select the required file from your
local machine.
6. In Description, enter a description.
7. Click OK to add the selected Attachment as a Reference.
8. The referenced Attachment appears in the References to be added on Save
list on the Request’s detail page.
The Reference has not been added yet.

9. Click Save.
The Attachment is added to the Request.

Valid References
The valid References for a Request are listed in Table 4-1.
Table 4-1. Valid References in the Reference tab
Type
Attachment

Description
Attach a file from a local machine to the current Request. The
attached file is copied to the server and can then be accessed by
other users. This feature is particularly helpful when you need to
reference a document that is not already Web accessible.
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Table 4-1. Valid References in the Reference tab [continued]
Type

Description

Package
(Existing)

Reference existing Packages directly from the Reference tab.

Package (New)

New Packages can also be created from a Request in the
References tab.
Also, if configured as part of the current Workflow, you can spawn
a Package from a step in the Request’s Workflow. When this
happens, a reference to that Package is automatically generated,
establishing a two-way link between the Request and the
referenced Package.

Project

Reference a Project in Mercury Project Management.

Release

Associate a Request with a Release by referencing the Release
name.

Request
(Existing)

Reference other Requests directly from the Reference tab.

Request (New)

New Requests can be created from an existing Request in the
References tab.
Also, if configured as part of the Demand Management Workflow,
you can spawn a Request from a Request. When this happens, a
reference to that Request is automatically generated, establishing
a two-way link between the Requests.

Task

Reference a Task in a Mercury Project Management.

URL

Reference URLs from a Package. Once attached, click on the
Web address to open the document in your Web browser. The
document must be in a MIME format recognized by the Web
browser (Word, Excel, etc.)
Use URLs to include more detailed information than what is
included in the Package notes, such as a screenshot for a Bug or
a report.

Reference Dependency Relationships
The relationships between a Request and a Reference are listed in Table 4-2.
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Table 4-2. Reference Relationships
Entity

Relationships

Description

Attachment Standard Attachment
interaction

The attachment is related to this Request.

Packages

Child of this Request

(Informational) - The selected Package is the child of the
Request.

Related to this Request

(Informational) - The selected Package is related to the
Request.

Predecessor

(Blocking) - Action is not allowed on the Request until the
referenced Package closes.

Successor

(Blocking) - Action is not allowed on the referenced
Package until the Request closes.

Projects

Related to This Request

(Informational) Selected Project is related to this
Request.

Releases

Contains This Package

The Request is contained in the selected Release.

Requests

Duplicate Request

(Informational) The referenced Request is a duplicate of
the Request.

Original Duplicate Requests

(Informational) The referenced Request is the original of
the two duplicate Requests.

Parent of this Request

(Informational) The referenced Request is the parent of
the Request.

Child of this Request

(Informational) The referenced Request is the child of
the Request.

Related to this Request

(Informational) Referenced Request is related to this
Request.

Predecessor

(Blocking) Action not allowed on this Request until the
referenced Request closes.

Successor

(Blocking) Action not allowed on the referenced Request
until this Request closes.

Related to This Request

(Informational) The referenced Task is related to this
Request.

Predecessor

(Blocking) Action not allowed on this Request until the
referenced Task closes.

Successor

(Blocking) Action not allowed on the referenced Task
until this Request closes.

FF Predecessor (Finish Finish
Predecessor)

(Blocking) The referenced Task does not complete until
the Request closes.

Request Updates Task

(Auto-updating) The referenced Task is automatically
updated by the Request.

Tasks
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Table 4-2. Reference Relationships [continued]
Entity
URL

Relationships
Standard URL interaction

Description
(Informational) The URL is related to this Request.

Saving an Un-Submitted Request
Mercury ITG Center can be configured to save an un-submitted Request. This
feature requires the application administrator to alter a server configuration
parameter. Enabling this feature might not be desirable for your business
situation. Contact the application administrator for help with this setting.

The server parameter used to enable this feature is
ALLOW_SAVE_REQUEST_DRAFT.

Adding and Editing Contacts
Users belonging to appropriate Security Groups (Mercury Demand Management
and User Manager) can add or edit a Contact using the Contact

Contact Manager
Workbench.

This section covers the following topics:

• Adding a Contact
• Editing an Existing Contact

Adding a Contact
To add a new Contact:
1. From the Mercury ITG Menu bar, select Administration > Open
Workbench.
The Workbench opens.
2. From the Shortcut bar, click Demand Mgmt > Contacts.
The Contact Workbench window opens.
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3. Click New Contact.
The Contact window opens.

4. In the top portion of the window, enter the standard contact information.
5. This includes entering the information described in the following table:
Field / Button

Description

Username

The Mercury ITG Username of the Contact. This field is
populated from the KNTA - User Id - All Validation. The
values in this field cannot be edited by the user through this
window.

Company

The company employing the Contact. This field is populated
from CRT - Company Validation. The values in this field
cannot be edited by the user through this window. Users
should select a company from the list or contact the
Administrator to alter the field values.

6. In the lower portion of the window, enter any additional information that
has been configured for your site.
This additional information is configured by an application administrator
using the Mercury ITG User Data functionality. Contact User Data
information is highly configurable and can be customized to capture
contact information related to specific business requirements. For
information on using User Data functionality, see Configuring a Request
Resolution System.
7. In Enabled, check Yes to include this Contact in a list of available Contacts.
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8. Click OK.
This Contact can now be used in the Contact fields in the Request header.

Editing an Existing Contact
To edit an existing Contact:
1. Open the Contact Workbench window.
2. Entering search criteria in the appropriate field (such as First Name, Last
Name or Username).
3. Click List.
The results from the search are displayed in the Results tab.

4. Select the user.
5. Click Open.
The Contact window opens with the user’s information loaded.
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6. Make the required changes.
7. Click OK.
The edited Contact information is saved.
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Chapter

Viewing Request Status and Details
This chapter discusses the ways a user can locate and view Requests. Once a
Request has been created, it begins moving towards completion along its
designated Workflow. Mercury Demand Management users can search for and
view a Request at any point in the Request’s lifecycle, provided they have the
appropriate permissions.
This chapter covers the following topics:

• Searching for Requests
• Viewing Request Information
• Viewing the Request or Request Field Help
• Printing a Request
• Using Dashboard Portlets to View Request Information

Searching for Requests
Once a Request is created, it can be viewed and updated. The procedures in
this section detail how to search for an existing Request using the standard
interface.
This section covers the following topics:

• Searching for a Specific Request
• Using Simple Searches
• Using Advanced Searches
• Saving your Searches
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Searching for a Specific Request
If the number of the Request is known, you can enter it into the View Details for
field at the top of the Request Search page.

Request #

To search for a specific Request:
1. From the menu bar, select Search > Request.
The Request Search page opens.
2. In View Details for Request #, enter the Request number.
3. Click Go.
The Request’s detail page opens.

Using Simple Searches
To locate a Request:
1. From the menu bar, select Search > Requests.
The Search Requests page opens.
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Click Requests to
open the Search
Request page.

2. In the Search Information section, enter the search criteria for the Request.
You can limit the maximum number of results in Maximum Requests
Displayed. In general, search for a Request based on any parameters
appearing in the Requests Search page, such as Request Number, Request
Type, or Created By.
3. (Optional) In the Results Display Options section, enter the display options
for the Request Search Results page.
The Choose Columns section allows you to select which columns to display.
All columns in Selected Columns will be shown in the Request Search
Results page.

• Use the side-to-side buttons
Columns

to move entries between Available

and Selected Columns.

• Use the up-and-down buttons to order the entries in Selected Columns.
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• The Request # and any other entries marked with an asterisk (*) cannot
be removed from Selected Columns.

4. (Optional) Save the search criteria for future searches.
To save the search criteria:
a. In Save this search as, enter a unique name for the search query.
b. Click Save.
The search is saved. Entering a non-unique name will prompt you to
replace the existing saved search query of the same name. See “Saving
your Searches” on page 56 for more information about saving
searches.
5. Click Search.
The Request Search Results page opens. The Request Search Results page
displays all of the Requests matching the search criteria. The Column Sort
Icon (
) denotes the column on which the data is sorted and the sort
direction (ascending or descending). Clicking the header with the Column
Sort Icon changes the order of the sort, such as from ascending to
descending. To select a different column to sort on, click another column
header.
The sort criteria is applied across the whole set of returned values, not just
those values displayed on the active page.
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If the search did not yield the desired results, click Modify Search to return
to the Request Search page. The search fields contain the existing
parameters, allowing you to modify the search without having to enter
everything a second time.
Export the search results into a Microsoft Excel spreadsheet by clicking the
Export Data to Excel link at the bottom of the Request Search Results page.

6. Click on the Request Number.
The Request’s detail page opens. To move from one Request to another,
use the forward and backward navigation buttons.

Using Advanced Searches
Each Request Type contains fields specific to that Request Type. The Advanced
Search functionality allows you to perform searches using any field contained
on the selected Request Type.
If searching for Requests of a particular Request Type, fill in the Request Type
field and click Advanced Search. The Advanced Search page opens, containing
fields specific to the desired Request Type.
If searching for Requests from several Request Types, fill in the Request Type
field and click Advanced Search. The Advanced Search page opens, containing
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any field that all the selected Request Types share. The search results will be
all Requests of the selected types that have the entered values in the shared
fields.

When the Advanced Search page opens, the selection of Request fields shown
in the search results (the values in the Choose Columns) fields might change
from the Search page. This results when a selected Request Type is
configured to display a different set of columns. To override the default
columns, edit the Available Columns and Selected Columns fields.

Saving your Searches
Demand Management allows search queries to be saved, organized, and
reused. This eliminates the need to re-enter search criteria for any searches
performed on a regular basis. A search query can be saved from the following:

• A Search Requests page.
• An Advanced Search Requests page.
• A Request Search Results page.
Access the Manage Your Saved Searches page from any of these pages by
clicking Manage Saved Searches or selecting Search > Saved Searches >
Manage Saved Searches from the menu. The Manage Your Saved Searches page
lets you create categories for organizing saved searches. See “Organizing
Saved Searches” on page 57 for more information on organizing saved
searches.
To save search queries:
1. From the menu bar, select Search > Request.
The Request Search page opens.
2. In the Search Information section, enter the search criteria for the Request.
3. (Optional) In the Results Display Options section, enter the display options
for the Request Search Results page.
4. In Save this search as, enter a unique name for the search query.
The search query name can be entered:
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• In the Search Results page or Advanced Search Results page before
performing the search.

• In the Request Search Results page after performing the search.
5. Click Save.
The Save Search confirmation page opens.

6. From the Save Search confirmation page, click one of the following:

•

Return to Search Results

Return to the page where the search was initiated.

•

Managed Saved Searches
Go to the Manage Your Saved Searches

page.

The search query is saved under the default No Category section of the
page.

Manage Your Saved Searches

Organizing Saved Searches
Saved searches can be organized under different categories created on the
Manage Your Saved Searches page.
To organize saved searches:
1. From the menu bar, select Search > Request.
The Request Search page opens.
2. Click Manage Saved Searches.
The Manage Your Saved Searches page opens.
By default, the saved searches are listed under No Category until moved into
the appropriate category.
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3. Create a new category.
To create a new category:
a. Click Add New Category.
A new Category Name area displays on the page.

b. In Category Name, enter a unique name for the category.
The Up/Down directional arrows and Delete button to the left of the
Category Name let you change the position of the category on the page
or delete the category from the page.
The Up/Down directional arrows and Delete button to the left of the
saved searches let you change the position of the searches within the
Category or delete the saved search from the Category. You can also
move searches between Categories.
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Change the name of the Category by editing it in Category Name.
However, the names of the saved searches cannot be changed.
4. When the Manage Your Saved Searches page is set up correctly, click Save.
The saved searches shown in the following example are organized into Dev
and My Requests categories. The Manage Your Saved Searches page is
shown below after the Categories have been created and the appropriate saved
searches have been moved into those categories.

Requests

Running Saved Searches
To run a saved search:
1. From the menu bar, select Search > Saved Searches > saved search.
The saved search runs.
This example details how to run the saved search, Critical Requests, located
in the Dev Request category. From the Menu bar select:
Searches > Saved Searches > Dev Requests > Critical Requests

Viewing Request Information
In addition to viewing the information displayed in a Request’s detail page,
users can view additional information concerning their Requests.
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This section covers the following topics:

• Viewing the Workflow Step Information URL
• Viewing the Graphical View of the Request
• Viewing the % Complete
• Viewing the Approval Details of a Step
• Viewing the Members of a Security Group for a Step
• Viewing the Request Transaction History
• Viewing the Request Execution Log

Viewing the Workflow Step Information URL
Each Workflow Step can be associated with a Web address (URL) during
Workflow configuration. This can help provide more instructions or
background information on the specific step. If a URL is associated with the
Workflow Step, the Workflow Step Name appears as a hyperlink. Click the link
to display more information concerning the step.

Viewing the Graphical View of the Request
To graphically view a Request’s process and its status:
1. Open the Request.
2. Scroll down to the Status section.

3. Click Graphical View.
The Graphical Workflow page for this Request opens.
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4. Click Done to return to the Request’s detail page.

Viewing the % Complete
Workflows can be configured to include a Current % Complete value. A Current
value can be assigned to individual Workflow steps. As the
Request moves along the Workflow, the percent completed is updated
according to each step’s configured value.

% Complete

To view the percent completed information for a Request:
1. Open the Request.
2. Scroll down to the Status section.

3. Click Graphical View.
The Graphical Workflow page for this Request opens.
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The Graphical Workflow page displays the Request’s Workflow. The Current
% Complete value for each Workflow Step also appears.
4. Click OK to return to the Request’s detail page.

Viewing the Approval Details of a Step
Some Workflow Steps can be configured to require approvals from more than
one user.
To view the approval details of a Workflow Step:
1. Open the Request.
2. Scroll down to the Status section.

3. Click the Approval Details link.
The Approval Details page opens.

62

Viewing Request Status and Details

Processing Requests (Demand Management)

4. Click Done to return to the Request’s detail page.

Viewing the Members of a Security Group for a Step
To view the members of a Security Group who can act on a particular
step:
1. Open the Request.
2. Scroll down to the Status section.

3. Click the Approval Details link.
The Approval Details page opens.
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4. Click the name of the Security Group to view.
The Security Group Members page opens. This page opens the Security
Group page in a new browser window and includes the names of all its
members.

Viewing the Request Transaction History
To view the Request Transaction History for a particular Request:
1. Open the Request.
2. Scroll down to the Status section.

3. Click the Transaction Details link.
The Request Transaction History page opens.
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4. Click Done to return to the Request’s detail page.

Viewing the Request Execution Log
It is possible to view the details of the execution of a particular Request by
running the Request Execution Log.
To view the Request Execution Log for a particular Request:
1. Open the Request.
2. Scroll down to the Status section.

3. Click the log link.
The Request Execution Log page opens. From this page, you can view the
details of the Request Execution.
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4. Click Done to return to the Request’s detail page.

Viewing the Request or Request Field Help
Demand Management provides customized help content for Requests.
Wherever the help content has been configured (on a field, section, or Request
Type), end users can open that help by clicking the associated Help Content
icon ( ).
To view the Request or Request field help:
1. Open the Request.

2. Click the Help Content icon (
The Help Content page opens.
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Printing a Request
It is possible to print a Request’s detail page by opening the Printable Version
page of the Request.
To print a Request:
1. Open the Request.
2. At the top of the Request’s detail page, click the Printable Version link.
A printable version of the Request’s detail page opens in a separate page.

3. On the printable version page, click Print.
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The Request’s printable version page is sent to the printer.

The printable version of the Request’s detail page cannot be edited or
updated.
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Using Dashboard Portlets to View Request Information
The Dashboard enhances the interaction with business data by providing
configurable views into the data. Each licensed product has a number of
associated Portlets which can be added to a user’s Dashboard.
The Dashboard can be personalized to meet the goals of a variety of users. It
can be configured to communicate expectations to all levels of users. The
Dashboard can also provide a central location from which managers,
executives and participants can view track and update their business activity
statuses. Using the Dashboard provides instructions for common Portlet
personalization tasks and highlights a few possible Portlet configurations that
provide specific advantages related to a variety of business roles.

The quickest way to locate open Requests is through the Dashboard. For
example, the My Requests Portlet can be used to display all of your assigned
Requests. The Dashboard features additional Portlets that can help manage
Requests. See Using the Dashboard for more detailed information.

Viewing Request Status and Details

69

Processing Requests (Demand Management)

70

Viewing Request Status and Details

Processing Requests (Demand Management)

Chapter

Processing Requests
This chapter details the procedures to track and process Requests. Once a
Request has been submitted, it is routed along a defined business process of
approvals, decisions and actions.
This chapter covers the following topics:

• Request Processing - Data Integrity
• Locating In Progress Requests
• Updating Request Information
• Configuring Workflow Display

Request Processing - Data Integrity
Information gathered for a business process is necessary for the Request to
reach a point of resolution. While much of the information for a Request might
be available at the time of initial entry, there are other pieces of information
acquired only after the Request starts processing. Some of this data might be
crucial to the resolution of the Request.
In order to make allowances for these requirements, Mercury Demand
Management incorporates the concept of conditional behavior for fields. This
ensures that the correct information, according to the defined business process,
is always obtained.
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When a Request is first entered, it might be entered by a non-technical person
trying to solve a technical issue. For example, a user might report a problem
using a Request Type called Software Bug. At this stage, the field by the name
of Estimated Time to Fix is not required and appears as black text.
When the Request proceeds to the next step, it is assigned a Request Status of
New. In this step, the person working on the problem is REQUIRED to fill in
the Estimated Time to Fix field. The (now required) field is displayed with a red

asterisk by it and does not allow the technician to advance the Request to the
next step of the Workflow until the field is filled in.

Locating In Progress Requests
Demand Management users can locate Requests requiring their attention by:

• Using Searches
• Using Notifications

Using Searches
Use the Search Requests page to search for Requests. Select Search > Request
from the Menu bar to access the Search Requests page. See “Searching for
Requests” on page 51 for details.

Using Notifications
As a Request proceeds through its life, email Notifications can be sent to alert
users of pending actions. Notifications can be sent:

• At a specific step in the Request resolution process.
The logic regarding when emails are sent and the content for each email is
defined in the Workflow. For example, Notifications can be sent when a
step becomes Eligible, alerting specific users that they need to perform an
action or decision. They can also be sent after a step is completed to inform
assigned users of the specific outcome.

• When a specific field value changes.
Certain fields on the Request Type can be configured to send a Notification
when a field changes to a specific value or any value. The following fields
can be configured to send a Notification:
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•

Company

•

Request Group

•

Assigned Group

•

Priority

•

Application

•

Assigned To

•

Department

•

Sub-Type

•

Contact Name

Notifications typically instruct the user to review a Request or act on a pending
Workflow step. Follow the instructions detailed in the Notification for the
appropriate course of action.
The Notification might include a hyper-link to the Request. Enter this URL
into a Web browser to proceed to the destination. If you are currently logged
onto the Dashboard, the referenced Request opens. If you are not currently
running Mercury ITG Center, the logon page opens. After you logon, the
referenced Request opens. Figure 6-1 shows a sample Notification.

Figure 6-1 Sample Notification

Updating Request Information
In Mercury Demand Management, once a Request has been created it can be
updated.
This section covers the following topics:
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• Updating the Request Header
• Updating Request Details and Notes
• Updating Request References
• Updating Request Status
Demand Management takes into account the status of the Request and the
permissions granted to the user. For Power Users, all fields are editable and
Workflow Step transitions can be made. Standard Users can only add
References, Notes, and make Workflow Step transitions. Whether a user can
edit a Request depends on the security model for the Workflow and the
Request Type. See Configuring a Request Resolution System for details.

Updating the Request Header
To update header information for an existing Request:
1. Open the Request.
2. Scroll down to the Request Header section.

3. Enter any new Request Header field information.
For information concerning a specific field, click the Help Content icon
(
) next to the field.

4. Click Save to save the changes.
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Changing the Request Type
Changing a Request’s Request Type can change which fields are associated
with that Request. To reduce data entry when the Request Type is changed,
Demand Management attempts to map the fields from the original Request
Type to the fields of the new Request Type. When a match is found, the value
in the original field is copied to the new field for the new Request Type. Any
new fields remain blank during the change in Request Type.
Information associated with the old Request Type is not lost. A copy of the
Request, before the Request Type was changed, is archived for reporting and
auditing purposes.

To change the Request Type of an existing Request:
1. Open the Request.
2. Scroll down to the Request Header section.

3. Click Change, located next to Request Type.
The Change Request Type page opens.
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4. Select the new Request Type by checking the appropriate radio button.
If there is a large number of Request Types present in the system, enter
filtering criteria in Find and click Filter.
5. Click OK.
The change to the Request Type is saved. Click Cancel to return to the
Request’s detail page without changing the Request Type.

Updating Request Details and Notes
The ability to view and edit fields in a Request depend on the Request’s
security set up. See Configuring a Request Resolution System for details.
To update the details for an existing Request:
1. Open the Request.
2. Scroll down to the Details section.

3. Enter any new Details information.
4. Scroll down to the Notes section.
5. Open the Add Notes section.
Up to 32K of information can be entered per Request. To view existing
notes, open Existing Notes. Existing notes are presented in chronological
order with the most recent first. Existing notes can also be filtered, using
Show Only User Notes and Note Author.
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6. Scroll to the bottom of the page.
7. Click Save.
The changes to the Request are saved.

Updating Request References
References can be viewed, modified, and deleted from a Request’s detail page.
This section covers the following topics:

• Viewing a Reference
• Changing a Reference
• Deleting a Reference
For more detailed information on adding References to a Request, see “Adding
References” on page 28.

Viewing a Reference
To view a Reference:
1. Open the Request.
2. Scroll down to the References section.
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3. Click on the name of the Reference.
The Reference opens.

Changing a Reference
To modify an existing Reference relationship:
1. Open the Request.
2. Scroll down to the References section.

3. From the Relationship drop down list, select the relationship.
4. Click Save.
The changes to the Request are saved.

Deleting a Reference
To delete an existing Reference:
1. Open the Request.
2. Scroll down to the References section.
3. Click the delete button (
deleted.
The Reference is deleted.
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Updating Request Status
To update the status of a particular Request:
1. Open the Request.
Any available actions are displayed at the top of the page.

2. Click an action button (for example, Assign) to perform the Workflow Step
specified.
Depending on the nature of the action, the Workflow Action page might open,
presenting more detailed choices. For example, if the Assign transition is
selected, you might be required to specify the Assigned To user. In this case, the
Assigned To field becomes a required field.
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Approval details can be shown for Workflow Steps that require more than
one decision, as well as Security Groups that can act on a particular step. For
more information, see “Viewing the Approval Details of a Step” on page 62.
Subworkflow Steps found within a Workflow are displayed sequentially
along with the other Workflow Steps. Subworkflow steps are numbered with
additional decimal places corresponding to the level of the Workflow. For
example, if Step 3 of a top-level Workflow is a Subworkflow, its steps will
be displayed as 3.1, 3.2, 3.3, etc. Similarly, if the second step in that
Subworkflow is also a Subworkflow step, its steps will be displayed as 3.2.1,
3.2.2, 3.2.3, etc.

Workflow Actions can also be viewed from the Status section of the
Request’s detail page.

If the user has the appropriate permissions to act on an eligible step, a View
Available Actions link appears in the Step Status column. Users can then click
the link to open the Workflow Action page to process their step.
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Delegating a Decision
For situations where someone else should make a decision, Workflow Steps
requiring an Approve All or At Least One decision allow the delegation of that
decision to another user.
To update the status of a particular Request:
1. Open the Request.
Any available actions are displayed at the top of the page.

2. Click Delegate Decision.
The Application Enhancement page opens.

3. In Delegate To, select the delegate from the drop down list.
4. (Optional) In the Notes section, enter additional information.
5. Click Done.
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Bypassing a Decision or Execution
From time to time, it might be necessary or desirable to bypass a Decision or
Execution step. If the step is configured to allow a bypass, a radio button
choice or auto-complete field appears in a Workflow action page, such as,
Approve Bug Fix.
To bypass a Decision or Execution:
1. Open the Request.
2. Scroll down to the Status section.
3. Click the name of the Execution Step.
The Workflow action page opens.
4. Check the Bypass radio button.

5. Click Done.
If you are bypassing an execution step, the Workflow Action page will change
and ask for a result for the bypassed execution. Select the desired outcome
and click Done.

Scheduling an Execution
To schedule an Execution:
1. Open the Request.
2. Open the Execute Request Commands page.

82

Processing Requests

Processing Requests (Demand Management)

To open the Execute Request Commands page:
a. Scroll down to the Available Actions section.
b. Click Schedule Execution.
or
c. Scroll down to the Status section.
d. Click the name of the Execution Step.
The Execute Request Commands page opens.

3. In Execution Date/Time, enter the date and time for the Execution.

4. Click Done.
The Execution will run at the scheduled time.

Overriding Reference Relationships
Reference relationships make it possible for a Request to wait for other
Requests to finish processing before making progress. Occasionally, it might
be necessary or desirable to override such a relationship, enabling a Request to
continue processing regardless of References to other Requests.
To override a Reference relationship:
1. Open the Request.
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2. Click Override at the top of page.

The Override button only appears if you have the proper Access Grants to
override the Reference relationship.
The Request will proceed normally along its Workflow. The Reference
details in the References section is updated to show that the
relationship has been overridden.

Relationship

Spawning a New Request from a Request
In the process of resolving a Request, a new issue might come up that requires
the creation of a new Request. New Requests can be created from an existing
Request in two ways:

• At any time from the References section of the Request’s detail page.
For more detailed information on creating a new Request from the
References section, see “Creating a Request from the References Section”
on page 26.

• At a pre-defined Workflow Step.
Mercury ITG Request Workflows can be configured so that they generate a
Mercury ITG Request at specific points in the Request resolution process.
To create a new Request at a step in the resolution process:
1. Open the Request.
2. Scroll down to the Status section.
3. Click Create Request or the appropriate link.
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The Application Enhancement page opens.

4. In Request Type, select a Request Type.
5. Click Create.
The Request Submission page opens.
6. Fill in all appropriate fields.
7. Click Submit.
The Request is submitted and saved.
The status of the Create Request step of the original Request is set to
The new Request is referenced as the child of the original
Request.
Successful.

Users can view the details of the Request in the newly created Status section.
Overall Request information can also be viewed from the References section
of the original Request.

Creating a New Package From the Request
Demand Management is tightly integrated with Mercury Change Management,
providing a closed loop system for Requests requiring software changes. In the
process of resolving a Request, some code might need to be deployed using a
Mercury ITG Package. From the Request, create a Package in one of two
ways:

• At any time from the References section of the Request’s detail page.
For more detailed information on creating a new Package from the
References section, see “Attaching Packages” on page 33.
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• At a pre-defined Workflow Step.
Mercury IT Governance Request Workflows can be configured so that they
generate a Mercury IT Governance Package at specific points in the
Request resolution process.
To create a new Package at a step in the resolution process:
1. Open the Request.
2. Scroll down to the Status section.
3. Click Create Package or the appropriate link.

The page refreshes to display the New Package page. Matching header
information is defaulted in the Package page, such as Description, Priority,
and Package Type.

4. Enter any additional Header information or Notes.
5. Click Save.
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The Package is saved.
Note that the standard interface can not be used to add Package Lines.
Package Lines must be added using the Workbench. See Processing
Packages (Change Management) for details.

Once the Package is completed, it automatically sends its final state (Closed Success, Closed - Failed, Closed - Mixed, Cancelled) back to the Request. The
Request then uses this final state as the result for the Create Package Workflow
Step and moves forward based on the given Workflow definition.

Re-Opening Closed Requests
A Request can be re-opened at a pre-configured step in the process. For
example, if a bug Request is generated which is subsequently closed and the
bug reoccurs, the Request can be re-opened instead of creating or copying a
new Request.
The following is the list of users who can re-open a closed Request:

• Mercury Demand Management Managers
• Creators of the Request
• Assigned Users
• Members of the Assigned Group
• Members of one of the Groups authorized to act on the Workflow
To re-open a Request:
1. Open the closed Request.
2. Scroll down to the Status section.
3. Click Reopen Request.
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Configuring Workflow Display
Configuring which Workflow Steps in the Status section are displayed is done
in the User Profile window of the Workbench.
To configure which steps are displayed in the Request status section:
1. Open the Workbench.
See “Launching the Workbench” on page 20.
2. From the Workbench menu, select Edit > User Profiles.
The User Profiles window opens.
3. Click the Workflow Status tab.
4. From the Workflow Steps drop down list, select either Show all Workflow
Steps or Specify steps to show.

If Specify steps to show is chosen, the following options are available:

•

show traversed steps

Choose whether or not to see steps that have been completed and
are no longer active.

•

hide immediate and condition steps not in progress

Since immediate Execution or Condition steps typically cannot be
acted on, these steps can be hidden.
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Chapter

Managing Requests
This chapter details the procedures to manage Requests. In Mercury Demand
Management, once a Request has been submitted, it can be viewed, changed or
deleted depending on changes to the business requirements or Workflow.
This chapter covers the following topics:

• Deleting Requests
• Canceling Requests
• Printing Requests
• Using Reports to Manage Requests
• Using the Dashboard to Manage Requests

Deleting Requests
Only saved Requests can be deleted from Mercury IT Governance Center. In
order to delete a saved Request, a user must have the Demand Mgmt: Manage
Requests Access Grant.
To delete a Request:
1. Open the Request.
2. Scroll to the bottom of the Request’s detail page.
If you have the appropriate permissions to delete the Request, the Delete
button will be visible.
3. Click Delete.
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A question dialog opens prompting for a confirmation on the deletion.

4. Click OK to delete the Request.

Canceling Requests
Requests can be canceled. In order for you to cancel a Request, you must have
the Demand Mgmt: Manage Requests Access Grant. Only submitted Requests
can be cancelled.
To cancel an existing Request:
1. Open the Request.
2. Scroll down to the Status section.
3. Click Cancel Request.

A question dialog opens prompting for a confirmation of the cancellation.
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4. Click OK to cancel the Request.
This cancels each Workflow Step and sets the Request Status to Cancelled.

Printing Requests
It is possible to print a Request’s detail page by opening the Printable Version of
the Request’s detail page.
To print a Request:
1. Open the Request.
2. At the top of the Request’s detail page, click the Printable Version link.
A printable version of the Request’s detail page opens in a separate page.

3. On the Request’s detail printable version page, click Print.
The Request’s detail printable version page is sent to the printer.
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The printable version of the Request’s detail page cannot be edited or
updated.

Using Reports to Manage Requests
Demand Management features a pre-defined set of HTML-based Reports that
can be accessed using a Web browser. The Reports provided with Demand
Management display current detailed status of the Request’s activity at any
point in time. The following reports help track and manage Requests.
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See Reports Guide and Reference for detailed information on the Report
screens and extended functionality.

Resource Load Report by Priority
The Resource Load Report by Priority Report lists open Requests assigned to
users based on the filtering criteria that is entered. The report lists the Request
count per priority as well as the average age (from Request creation) of the
Requests in each priority bucket.

Request Detail Report
The Request Detail Report is the primary report in Demand Management. It
reports on Requests by a large number of selection criteria. For each Request,
the report can display:

• All the notes and/or References attached to the Request.
• The current status of the Request.
• A listing of transacted steps.
• All the populated detail fields for the Request.
Use this report to see Requests assigned to you or Requests ready for your
review. This report can also display all new Requests needing to be tracked.

Request Summary Report
The Request Summary Report offers the same ability to choose selection criteria
as the Request Detail report, but provides the total counts for groups of Requests
matching the selection criteria. Categorize and group selected Requests and get
the counts for each group. Figure 7-1 displays an example of the total number
of Requests created by a user, grouped by Priority.
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Figure 7-1 Sample Request Summary Report Grouped by Priority

Submitting a Report
For information on submitting a Request specific report, refer to “Mercury
Demand Management Reports” on page 95.

Using the Dashboard to Manage Requests
The Dashboard provides a powerful tool for managing Demand Management
Requests. From the Dashboard, managers can quickly view all incoming
Requests and assign them to team members. They can also configure
additional Portlets to monitor the Request activity based on the assigned user,
priority or Request Type.
For more detailed information, see Using the Dashboard.
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Chapter

Mercury Demand Management
Reports
Mercury Demand Management features a pre-defined set of HTML-based
reports that are accessed through a Web browser. These reports allow users to
view the current detailed status of their data at any point in time. Demand
Management also allows users to build their own reports.
This chapter describes the procedures used to submit and view reports in
Demand Management using both the Workbench and the standard interface.
This chapter covers the following topics:

• Reports
• Processing Reports

Reports
The reports shipped with Demand Management are listed in Table 8-1. These
reports can be accessed through both the Workbench and the standard
interface. All Mercury ITG Reports, including details for their parameters, are
in Reports Guide and Reference.
Table 8-1 lists all standard Report Types that have a product scope of
Mercury Demand Management or All Products.

Mercury Demand Management Reports
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Table 8-1. Demand Management Reports
Report

Description

Contact Detail Report

Queries the Contacts entered in your Mercury Demand
Management system as you enter and update Requests.

Contact Synchronization Report

Provides an interface for ensuring that the Demand Management
Contacts are properly defined. This report can detect all users
with no corresponding Contact record and then create a Contact
record for them. This report also searches for and corrects
discrepancies between the Contact and user information within
the system.

Notification History Report

Workflow report that lets you view Notifications that have been
sent or are pending. It contains such information as: Notification
Date, Entity Type, Subject of the Notification, and Recipient List.

Portlet Detail Report

This is an application administrator Report used to return the
details of a Portlet or range of Portlets. It lists the Portlet’s
columns, as well as the SQL query used by the Portlet to retrieve
data from the system. The Portlet’s filter fields and security
configuration can also be listed.

Report Type Detail Report

Displays the parameters and parameter details for each Report
Type. It also displays the exact commands used to run the report.

Request Detail (Filter by Custom
Fields) Report

Similar to the Request Detail Report except that you can filter for
Requests by values in custom fields. Specify the particular
Request Type to report on, select up to four of the custom fields
for that Request Type and run the report for specific values for
each of those fields.

Request Detail Report

Displays Requests based on a large number of selection criteria.

Request Header Type Detail Report

Administration report that lists the detailed set-up information for
the Request Header Types. This report can be used to audit your
set-up as well as help debug any problems with Requests using a
given Request Header Type. You can also display information
about field filters that have been selected for the Assigned To,
Assigned Group and Contacts fields.

Request History Report

Lists the complete Workflow and field change history for each
selected Request. The report provides details of every change in
the status of each Workflow Step for selected Requests.

Request Listing Report

Provides a useful interface for viewing selected Request
information. It lets you select various fields for inclusion or
exclusion and specify the desired display order. The Request
Listing Report can also be used to export data to MS Excel or
another data analysis tool. This report’s output is formatted as an
HTML table that can be copied and pasted from your Web
browser into the data analysis tool.

96

Mercury Demand Management Reports

Processing Requests (Demand Management)

Table 8-1. Demand Management Reports [continued]
Report

Description

Request Quick View Report

Lists a quick summary of open and closed Requests, breaking
down the Requests by priority. The report also shows the Request
activity for the current week (using a Sunday to Saturday week) in
regards to Requests opened and Requests closed. The report can
also show selected Request information for each of the individual
open Requests, allowing managers to see both a summary view
on Request activity and one level down in Request detail.

Request Summary (Filter by Custom
Fields) Report

Similar to the Request Summary Report except that you can filter
for Requests by values in custom fields. Once the Request Type
to report on is specified, select up to four of the custom fields for
that Request Type.

Request Summary Report

Gives the total counts for groups of Requests matching the
selection criteria. You can categorize/group selected Requests in
as many as five categories and get the counts for each group.

Request Type Detail Report

Administration report that lists the detailed set-up information for
your Request Types. This report can be used to audit your set-up
as well as help debug any problems with Requests of a given
Request Type. You can also display information about which
Security Groups are allowed to create Requests of a specific
Request Type, and which Workflows can be used in a specific
Request Type.

Resource Load Report by Priority

Lists all open Requests assigned to different users based on the
filtering criteria that you select. The report lists the Request count
per priority as well as the average age (from Request creation) of
the Requests in each priority bucket.

Security Group Detail Report

Lists set-up information for a single Security Group or a group of
Security Groups. It displays such information as which users
belong to the group, what Workflow Steps the Security Group has
access to, and what screens the users in the Security Group can
update. The report can also display which entities can use a
Security Group’s information in its search fields, and which
Request Types that members of a designated Security Group are
allowed to create.

Special Command Detail Report

This report lists details for a special command, or a range of
special commands.

User Data Detail Report

The User Data Detail report displays the definition of each custom
User Data field. The report is grouped by entity and lists all the
custom fields for each entity. It also lists referenced Validations for
the fields.

User Detail Report

Lists the users defined in your system, licensing information for
the user and the Security Groups description attached to each
user.
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Table 8-1. Demand Management Reports [continued]
Report

Description

Validation Report

Application administration report on the various custom
Validations. These can be Validations that you entered into the
system or those that are standard with products.

Workflow Detail Report

Displays the complete definition of a specific Workflow or a set of
Workflows. This report is useful for auditing and analyzing
Workflow business process, User Data, Subworkflows, Workflow
Step commands and expanded Special Commands.

Workflow Statistics Report

Provides statistical information regarding the usage of the
Workflow.

All Report Types ending with ‘Report’ are textual reports that list details
about specific entities.

Processing Reports
Demand Management reports can be run from the Workbench or the standard
interface. Similarly, previously run reports can be viewed from either interface.
This section covers the following topics:

• “Submitting a Report from the Workbench” on page 98
• “Submitting a Report from the Standard Interface” on page 101
• “Viewing Previously Submitted Reports from the Standard Interface” on
page 104

• “Viewing Previously Submitted Reports from the Standard Interface” on
page 104

Submitting a Report from the Workbench
To submit a report from the Workbench:
1. Open the Workbench.
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See “Launching the Workbench” on page 20.
2. From the Shortcut bar, click Demand Mgmt > Reports.
The Report Submission Workbench window opens.
3. Click New Report.
The New Report Submission window opens.
4. From the Report Type auto-complete list, select the type of report to submit.
After selecting the Report Type, parameters appear in the Parameters tab
of the New Report Submission page. These parameters are report-specific
and change depending on the Report Type.

You might not have access to all Report Types. To access to a Report Type,
that is not listed, contact the application administrator for permission.
5. Fill in all the required parameters (as indicated by the red field label) and
any optional parameters for the report.
6. (Optional) Set up the schedule for running the report.
If no scheduling information is entered, the report runs immediately. To set
up the schedule:
a. Select the Scheduling tab.
The Scheduling tab opens.
b. Check Schedule the Report.

Mercury Demand Management Reports

99

Processing Requests (Demand Management)

The Scheduling Information section appears.
c. Fill in the scheduling parameters.
d. If needed, check Repeat Periodically.
The Recurrence Information section appears.
e. Fill in the recurrence parameters.

7. (Optional) Set up the Notification.
To set up the Notification:
a. Click the Notifications tab.
The Add Notification for Report Submission tab opens.
b. Click New.
The Add Notification for Report Submission window opens.
c. On the Setup tab, select any users who should be informed of the report
results.
d. On the Message tab, create the email message to send with the report.
e. Click OK to close the Add Notification for Report Submission window.
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8. Click Submit to run the report.
9. Click View Report to view the results of the report in a Web browser.
10. If the report fails, click View Log to view the technical details of the report
execution.

Submitting a Report from the Standard Interface
To run a report from the standard interface:
1. Logon to Mercury Demand Management.
2. From the menu bar, select Reports > Request Reports.
The Available Reports page opens.

Mercury Demand Management Reports 101

Processing Requests (Demand Management)

3. Select the report to be submitted by clicking the linked name of the Report.
Regular reports are available in separate sections of the Reports page. The
Report’s creation page opens.

Report creation pages display the fields associated with the Report.
Required fields are indicated by a red asterisk (*).
4. Fill in all the required parameters and any optional parameters for the
report.
5. Click Submit.
The Report Submitted page opens. The report’s output is displayed in a
separate page.
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Viewing Previously Submitted Reports from the Workbench
Reports can be restricted by permissions (Security Groups) and to the
originator. Contact the application administrator to get permission for reports
that are restricted by Security Groups.
To view previously submitted reports from the Workbench:
1. Open the Workbench.
2. From the Shortcut bar, click Demand Mgmt > Reports.
The Report Submission Workbench window opens.
3. In the Query tab, enter the search criteria.
4. Click List.
All matching report submissions are listed in the Results tab.

5. Select the report.
6. Click Open to view the criteria used for the report.
7. Click View Report to view the report output.
It is not possible to modify the values used for a previous report submission.
However, it is possible to copy an existing report submission and make
changes to the copy. The copied report can then be submitted.
To make a copy, Select a Report Submission on the Results tab of the Report
Submissions Workbench window and click Copy.
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Viewing Previously Submitted Reports from the Standard Interface
Reports can be restricted by permissions (Security Groups) and to the
originator. Contact the application administrator to get permission for reports
that are restricted by Security Groups.
To view a previously submitted report from the standard interface:
1. Logon to Mercury Demand Management.
2. From the menu bar, select Search > Reports.
The Report Search page opens.

3. In the Search Information section, enter search criteria.
4. Under Result Display Options, enter the maximum number of results to be
displayed.
5. Click Search.
The Report Search Results page opens. The page displays summary
information about any reports that match the search criteria.
6. Click the report number under the Report # column to see the output details
of any report.
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Appendix

Integrating Requests and Projects
Mercury IT Governance Center integrates issue tracking with project
management using Mercury Demand Management and Mercury Project
Management. Mercury Demand Management Requests and Mercury Project
Management Projects and Tasks can be linked to each other through a variety
of dependent and informational relationships. Utilizing these relationships,
Requests can be folded seamlessly into a scalable framework of interlocking
initiatives. Linking Tasks to Requests from Mercury Demand Management
also gives instant visibility to detailed activities supporting an overall project.
This appendix covers the following topics:

• Referencing Requests from Projects
• Creating Tasks from Requests
• Dependencies Between Tasks and Requests
• Visibility into Tasks and Requests

Integrating Requests and Projects Overview
This section lists the components required to integrate Requests and Projects.
These components are:

•

Mercury Project Management, A Project Management System

Mercury Project Management enables collaborative project management
for both repetitive projects, such as installing a new release of your HRMS
applications, and one-time projects, such as developing a new e-commerce
capability. With Mercury ITG, you accelerate project delivery while
reducing your project costs.
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•

Mercury Demand Management - A Request Resolution System

Mercury Demand Management is a Workflow-driven Request resolution
system for business applications. It allows you to effectively capture, route
and resolve business Requests.

•

Integration

Companies with both Mercury Demand Management and Mercury Project
Management can create processes that take advantage of each product’s
functionality.

Referencing Requests from Projects
Requests can be linked to Projects through an informational Reference
relationship. This is done from the References tab in the Project Information
window in the Workbench, or from the References section of the Project Detail
page.

Figure A-1 References tab

Creating Tasks from Requests
Occasionally, a Request can be filed by a user that would be desirable to make
into its own Task in a Mercury Project Management Project, creating for it
deliverable dates and track-able actuals. Tasks can be created from Requests in
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the Project Management Workbench. A Task created from a Request behaves
like any other Task in the Project, save for that the Tasks’s % Complete and
State are automatically updated by the originating Request as it moves through
its Workflow. The new Task has the dependency relationship Task Updated by
Request.
A manager in a software company wants to create a Project that will track all
of the bugs currently logged against a particular product. In the Workbench,
the manager can search for bug Requests related to the product, and turn them
into Tasks in the Project Plan. From there, the manager can perform any
typical Project action, such as tracking the completion dates for each Task or
monitoring triggered Exceptions.

You must be in the Project Management Workbench in order to create a Task
from a Request.

To create a Task from a Request:
1. Open the Project.
2. From the Project window, select Task Created From Request from the drop
down list at the bottom left corner of the window.
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3. Click Add.
The New Task From Request window opens.

4. To select the Request to attach, use one of the following methods:

• Select a Request number from the Request No. field.
• Click Search to search for Requests to add in a separate query window.
5. Click OK to create the new Task and close the window.
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The new Task has been created from the selected Request and is part of the
current Project. The Task is linked to the Request.

Dependencies Between Tasks and Requests
The dependencies that can be created between Requests and Tasks are
described in Table A-1.
Table A-1. Dependency Relationships - Requests to Tasks
Relationship

Description

Related to this Task

(Informational) - Selected Request is related to the
Task.

Successor

(Blocking) - Action not allowed on selected Request
until the Task closes.

Predecessor

(Blocking) - Action not allowed on the Task until the
selected Request closes.

FF Predecessor

(Finish Finish Predecessor: Blocking) - The Task and
Request complete together.

Task Updated by
Request

(Auto-Updating) The Task is automatically updated by
the selected Request.

For more detailed information on using these dependencies, see “Making
Tasks Dependent on Requests” on page 109 and “Making Requests Dependent
on Tasks” on page 113.

Making Tasks Dependent on Requests
When selecting dependencies between Tasks and Requests, there are many
relationships to choose from. These relationships are set by attaching a Request
to a Task as a Reference. This is done from the References tab in the Task
Information window in the Workbench, or from the References section of the
Task Detail page in the standard interface.
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Figure A-2 References Tab and References Section for Tasks

The following sections contain more detailed information on dependencies for
Tasks created from Requests.
This section covers the following topics:

• “Task Waits on Request Closure (Successor Relationship)” on page 110
• “Task Can’t Complete Until Request Closes (FF Predecessor)” on
page 111

• “Task Auto-Updated by Request” on page 112

Task Waits on Request Closure (Successor Relationship)
This Relationship dictates that the Task state cannot change until the
associated Request is closed. The Task will immediately move into a "Pending
Request" state. When the Request is closed, the Task can be acted upon once
more. This does not stop other fields from being edited.
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A software company’s Support Division makes the decision that no patches
will be released without accompanying documentation. The company has an
unfortunate history, however, of changing its mind about patches that are to
be released, and numerous times there have been documentation changes
made to accommodate patches that were cancelled after being initially
approved. Patch A’s approval Request is moving through its resolution
process in Mercury Demand Management. The Documentation team is ready
to begin making changes to all documents to account for Patch A, and has
created a Project in Project Management. The Project includes the Task Begin
Doc Changes for Patch A.
The Documentation Team’s manager creates a Reference to Patch A’s
Request from the Begin Doc Changes for Patch A Task, with the relationship
Successor . This way, the Task cannot be moved from its status of Ready to In
Progress until Patch A’s approval Request is closed, ensuring that the
documentation changes are valid and needed.

Task Can’t Complete Until Request Closes (FF Predecessor)
This Relationship dictates that the Task state cannot change to Complete until
the associated Request is closed. When the Resource working on the Task is
finished with it, and the State is set to Completed (% Complete will be set to
100%), this Task will move into a Completed (Pending Request) state. When the
Request is closed, the Task is then set to ‘Completed.’ This does not stop other
fields from being edited.
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A software company’s Support Division makes the decision that no patches
will be released without accompanying documentation, including bug fixes.
The Documentation Team wants to make sure that its documentation is
accurate and complete for every bug fix that takes place. The last step in the
company’s bug fix resolution process is a review by the person who
originally filed the bug. A Request to fix Bug 62547 has been filed and nearly
completed, necessitating changes to the documentation.
The Documentation Team has a Project in Project Management, one of
whose Tasks is Doc Changes Complete. The Documentation Team manager
creates a Reference to Bug 62547’s Request, with the relationship FF
Predecessor. This way, the Task cannot be fully completed until Bug 62547’s
fix has been approved by the Requestor, closing the Request
.

Request Resolution Process
Bug Fix
Request

Bug
Fixed

Final
Approval

Documentation Team Project

(Task Completed)
(Task Completed - Pending Request)

Task Auto-Updated by Request
This Relationship is for Tasks created from Requests. As the Request moves
through its process, it will update the Task with its status information. When
the Request is submitted, the Tasks moves to In Progress. When the Request is
completed, the Task is Complete. When the Request is cancelled or deleted, the
Task is cancelled. A single Request can drive multiple tasks. If the Request’s
Workflow has % Complete values defined, the Request will also update the
Task with % Complete information.
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Since % Complete and Task State are automatically updated by the driving
Request(s), users cannot update these two fields. The text “(Updated by
Request)” will be appended to the Ready and In Progress states to indicate
this.

Making Requests Dependent on Tasks
Requests can be made dependent on Tasks. This is done from the References
section of the Request page in the HTML interface.

Figure A-3 References Tab and References Section for Requests

The section, “Request Waits on Task Closure (Predecessor)” on page 113,
contains more detailed information on dependencies for Requests set by Tasks:

Request Waits on Task Closure (Predecessor)
This Relationship dictates that the Request’s user cannot perform any
Workflow Actions until the associated Task is closed (completed, bypassed, or
cancelled). The Request will immediately move into a ‘Pending Task’ status.
When the Task is closed, the Request can be acted upon once more. This does
not stop other fields from being edited.
A software company’s Support Division makes the decision that no patches
will be released without accompanying documentation. The Documentation
Team wants to make sure that any patch Request won’t close until the patch
documentation is finished. A Mercury Demand Management user is assigned
a Request going through the company’s patch approval/release process. At
the same time, the Documentation Team has a Project in Project
Management, one of whose Tasks is ‘Patch Docs Completed.’ The user creates
a Reference to that Task, with the dependency ‘FF Predecessor.’ This way,
the patch Request will not close until the ‘Patch Docs Completed’ Task is
complete.
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Visibility into Tasks and Requests
Mercury ITG Center provides the following for enabling visibility into
Request and Task integration.

• “Requests Holding Up Progress” on page 114
• “Project References Portlet” on page 114

Requests Holding Up Progress
You can search for Requests that are holding up progress on your projects.
Each Portlet in the Dashboard that deals with Requests includes the field
Preventing Action on Requests/Tasks. This field can be set to display Requests
that are preventing action on other Requests or Tasks.

Figure A-4 Request Portlet Filter Page Showing ‘Preventing Action On’ Field

Project References Portlet
You can also view References related to your Tasks and Projects using the
Project References Portlet on your Dashboard. Add the Portlet to your
Dashboard and then personalize it to show the References that are relevant to
your activities. The Portlet can be personalized to display References based on
the following information: Reference Types, Relationship, time period when
they were added, and whether or not they are preventing actions on Tasks.

Figure A-5 Project References Portlet
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